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4. Deselect the pupils (Cmd-D). Then at a highly magnified 
view, use the Eye Dropper Tool to set the Foreground Color 
to a Dark Gray from within the pupils.

5. Switch to the Brush Tool (“B”). Select a very fuzzy round 
brush; set Size small (hold left bracket ‘[‘ down), set 
Hardness to 0%; Set Mode to Normal; set Opacity to 50% 
(Ctrl-5) and set Flow to 100% (Shift 0). Then trace around 
the dark pupils to blend the edges of the pupils and cover 
light reflections at the edges of the iris.

6. Finally, change the Foreground Color to White (“D” and 
swap Fore- and Background). Set Opacity to 60% (Ctrl-6) 
and add some small highlights to the pupils. Clicking on 
the same pixel several times will brighten that pixel and to 
a lesser extent the ones around it to give gradations in the 
highlight.

�

Photoshop now has a neat tool to  
automate the removal of 

red eye on humans in photos, but there doesn’t seem to be 
an on-off switch for the headlights on pictures of our pets. 
My method is not a one-step process, but it’s really not that 
hard. In Photoshop:

1. Duplicate the picture in a new layer by going to the 
Layer>Duplicate Layer. On the new layer use the Magic 
Wand Tool and/or other Selection Tools to select the bright 
pupils.

2. Go to Select>Refine Edge. Set Smooth to 15 and Feather 
to 0.5.

3. Go to Image>Adjustments>Hue>Saturation. Set  
Saturation to -100 (MINUS 100). Set Lightness appropriate 
to the picture: more or less -50 to -75 (again, MINUS).

by Tom Bank, Sr.

Animal Eyes

The developers of Perian, the free and  
extremely popular video format extender 
for QuickTime, have announced that 

they are ceasing work on the project. In a statement on the 
project’s Web site, the developers have said that it’s time to 
move on, their goal of making video content playback 
easier on the Mac having been met.

What Perian Does — Described by its developers as a 
Swiss Army knife of video playback, Perian has long been 
among the first pieces of software I install on a new Mac. 
Out of the box, a Mac can play video through Apple’s Quick-
Time Player, which handles .mov, .m4v, and .mp4 files 
quite happily. Unfortunately, QuickTime Player throws its 
hands up in despair when asked to play .avi and .mkv files, 
which are common on the Internet, not to mention a host of 
more unusual formats.

This is where Perian comes – or, rather, came – in. Installed 
as a preference pane, Perian offers little in the way of 
configurable options. Instead, it simply operates in the 
background, quietly and transparently enabling QuickTime 
Player to play video formats not deemed worthy by Apple.

But Perian’s days are numbered. The developers have 
announced that support will cease 90 days after the 

by Steve McCabe 

QuickTime Format Extender Perian
to Cease Development

upcoming final update to Perian. Perian may, they say, 
continue to function under Apple’s forthcoming OS X 10.8 
Mountain Lion, or it may not.

The Perian people are making no promises, other than that 
they won’t be supporting Perian any longer. Time, they say, 
to move on to new projects; the source code will remain 
available for others to improve, but the existing development 
team won’t be working on it.

The Alternatives — It is quite likely that Perian will 
continue to function under releases of OS X for the near 
future, but it isn’t guaranteed, and so users like me, who 
have become dependent upon Perian to handle playback  
of movies not Apple-approved, will be looking for  
alternatives. Luckily, all of the main options are free.

The first contender is VLC. Like Perian, VLC has a wide 
reach, nimbly embracing all but the most exotic videos, 
including DVDs. And, if it’s in a really good mood, it can 
even provide a way to play DVDs from regions other than 
the region for which the computer has been set (a feature of 
interest to anime fans and many people outside the United 
States). I personally care little for VLC’s interface, though it 
cleaves more closely to Apple’s human interface guidelines 
than does the quirky QuickTime Player.

http://perian.org/
http://www.videolan.org/vlc/
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VLC, by virtue of its thoroughness and its longevity, 
has become the standard against which competitors are 
judged; foremost among them is MPlayer OSX Extended, 
which offers much the same feature set of its rival, includ-
ing spoggly and unreliable DVD playback, but little in the 
way of enhancements or embellishments that might make 
it a compelling alternative.

The same is true of UMPlayer, whose unoriginal name 
hides an extensive feature set. Sadly, though, UMPlayer 
is let down badly by jerky playback (unacceptable on a 2 
GHz i7 MacBook Pro), a reluctance to recognise my lap-
top’s DVD drive, and dialogs written by someone who, if 
we’re being charitable, has yet to master English. UMPlayer’s 
interface is strangely reminiscent of Windows Media Player, 
and its standout feature, YouTube playback and recording, 
is disappointingly dysfunctional – a YouTube search box 
in the top-right of the app’s main window returns search 
results, but UMPlayer seems incapable of actually playing 
selected videos.

Perian’s developers recommend NicePlayer, which is a nice 
piece of kit, though still in preview form for 10.7 Lion in a 
September 2011 release. Similar in its interface minimalism 
to QuickTime Player, NicePlayer eschews unnecessary 
extras such as YouTube access and DVD playback, focusing 
instead on what a media player should – the playing of 
media files. Sad, then, that it’s built on Perian, and so will 
likely end up stumbling and falling if Perian does.

Recommendations for the Perian User — Lack of 
support suggests, but does not by any means guarantee, 
future problems. Perian 1.2.3, the current release, works 
admirably under OS X 10.7.3, and unless Apple substan-
tially overhauls QuickTime in Mountain Lion, it seems fair 
to assume that Perian will function, at least adequately, for 
some time to come.

At some point, though, it will likely fail, and an alternative 
will then be required by anyone who needs to play an .avi 
or .mkv file on the Mac. NicePlayer seems unlikely to have 
a future separate from Perian. UMPlayer, frankly, could 
use some additional beta testing before being turned loose 
on the public. And while MPlayer OSX Extended shows 
promise, it feels a touch immature and unpolished.

And that leaves us where we started, with VLC. It might 
not be the last word in DVD playback, but right now the 
obvious candidate to start accepting Perian users looking 
for a new home is indeed VLC, a mature and stable media 
player that provides playback options for more file formats 
than one can reasonably shake a stick at.

http://www.mplayerosx.ch/
http://www.umplayer.com/
http://code.google.com/p/niceplayer/
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Apple supplemented its new laptop  
announcements and forthcoming  

update to OS X 10.8 Mountain Lion with plans to release 
iOS 6 in the third quarter of 2012 – we’re guessing October, 
to coincide with a new iPhone model. The new mobile OS 
version comes with what Apple counts as 200 new features, 
including a dramatically modified Maps app, smarter Siri 
integration, and a welcome Do Not Disturb mode. Accord-
ing to Apple, iOS 6 will work with the iPhone 3GS and 
later, the fourth-generation iPod touch, and the second- 
and third-generation iPad. It’s nice to see the iPhone 3GS 
being included in one more big iOS upgrade and, although 
not entirely surprising, it’s noteworthy that the original 
iPad will not run iOS 6.

Maps and Directions — It has been clear for months 
that Apple would abandon Google’s mapping software 
and support for the Maps app, despite a working relation     
advertised for new employees to work on its mapping 
service. But the new Maps app is more expansive than  
expected.

To start with, Apple’s new maps are vector-based, rather 
than being bitmapped images. Google constructs maps as 
pictures on a server and feeds out image segments; Apple 
sends vector data to its devices, which then build the maps. 
This is a classic split in the two companies’ philosophies. 
Apple says (and the demo shows) that this makes zooming 
and panning faster. It should also mean that much less data 
is transferred, as using vector data is a far more compact 
method of representing an area, especially as the user 
switches among different levels of magnification.

If you imagined hearing a loud groan during the Maps  
presentation, it was the sound of dozens of GPS satellite- 
navigation app makers picturing millions of dollars in lost 
sales due to the turn-by-turn directions feature that Apple 
has added for iOS 6. But our own Glenn Fleishman has 
reviewed nearly 20 of them for Macworld over the last 3 
years, and he feels there’s a lot of room for improvement – 
which is why it makes sense for Apple to step in here.

Apple says it’s integrating traffic conditions that are 
anonymously crowdsourced from iOS users who are also 
using Maps while driving to provide updating information 
about the best route. (Google has long done exactly this as 
well.) Many GPS navigation apps include traffic or offer 
it as an add-on, and rely on the same sort of traffic update 
information. But Apple’s Maps will be available to every-
one at no cost, which could instantly provide Apple with 
an extremely large pool of traffic data from the day it launches. 
(Android has offered free turn-by-turn directions since 

by TidBITS Staff 

Apple Previews iOS 6 for Fall Release

2009 in advance of most third-party navigation software 
for that platform.)

Maps adds some lovely eye candy in the form of Flyover, 
which Apple derived from aerial photography. Major cities 
around the world can be viewed as interactive 3D images. 
It’s an interesting way to explore a city, and a great demon-
stration. In practice, one wonders how much it will be 
used routinely, but we can imagine visitors planning a visit 
to a new city by spending evenings rummaging through 
flyovers. Several firms, including Microsoft, have offered 
spectacular 3D and interactive aerial views before, but this 
is the first time we know of this approach being available 
so extensively in a mobile app. (Google announced just a 
few days ago that it would be bringing interactive 3D visuals 
to Android in the near future.)

Apple has also put Yelp reviews and results onto its maps 
as clickable pins along with other local information. (Yelp 
and Google have a long-standing dispute about the use of 
Yelp’s information in Google’s local results, and the use of 
Yelp results in general searches. Apple will dramatically 
boost Yelp’s reach with this inclusion.)

A Smarter Siri — Siri, introduced in beta form with iOS 
5, controls an iPhone 4S with speech when, for example, 
you want to compose a text message, set a timer, or place a 
phone call.

Siri gets smarter in iOS 6 and expands its reach beyond just 
the iPhone 4S to the latest iPad – sorry to those who were 
hoping for backward compatibility with the original iPad, 
iPad 2, and the iPhone 4. Siri in iOS 6 also understands 
many more languages and can run in a new “Eyes Free” 
mode; this is invoked via a button on the steering wheel in 
certain new cars. (So yes, if you want to be completely up 
to date, you’ll have to buy a new car that’s compatible with 
your cell phone.)

The iOS 6 Siri update gains access to more information, 
such as sports statistics and scores for baseball, football, 
basketball, hockey, and soccer (nothing was said about 
worldwide results from the only sport Adam follows, dis-
tance running). Fortunately, as thinking about sports can 
work up an appetite, Siri can also help you satisfy your 
hunger more effectively, with access to much more restau-
rant information, via Yelp and OpenTable, so you can look 
for nearby places that feature outdoor seating and then 
book a reservation.

If you are using Siri in iOS 6 with the new Maps app, you 
can ask for a destination – such as a nearby restaurant – 
and Siri directs you there. And if you want to follow dinner 

http://www.apple.com/ios/ios6/maps
http://googleblog.blogspot.com/2009/08/bright-side-of-sitting-in-traffic.html
http://googleblog.blogspot.com/2012/06/never-ending-quest-for-perfect-map.html
http://www.apple.com/ios/ios6/siri/
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with a movie, Siri can provide access to movie showings, 
trailers, and reviews. For film buffs, Siri can find movie 
trivia, such as when a movie was released and who directed 
it. You’ll also be able to speak to Twitter and have Siri tweet 
what you say, post a Facebook status update, or add a 
comment to your Facebook wall.

Perhaps best of all, Siri can launch apps upon your spoken 
command. App hounds who have filled their devices with 
hundreds of programs can now bypass the iOS search 
screen to easily launch an app that’s stashed away in the 
fifth folder on the seventh Home screen – or that might not 
be showing at all if the screens are maxed out!

Auto manufacturers that Apple announced as already 
committed to delivering eyes-free Siri integration in the 
next 12 months include BMW, GM, Mercedes, Land Rover, 
Jaguar, Audi, Toyota, Chrysler, and Honda. Languages that 
Siri will support under iOS 6 include Korean; English/
French for Canada; Spanish for Spain, Mexico, and the 
United States; Italian; Italian, French, and German for Switzer-
land; Mandarin for Taiwan; Cantonese for Hong Kong; and 
Mandarin for mainland China and Hong Kong.

Do Not Disturb and Phone Reminders — A new Do 
Not Disturb timer in iOS 6 adds an option to pick a range 
of time to suppress vibration, keep the screen from lighting 
up, and silence any sounds on your iOS device. Anyone 
who sleeps with such a piece of hardware nearby will ap-
preciate Do Not Disturb’s tranquility. This feature will also 
be welcome to certain students, especially younger stu-
dents, who want to have their iPhones in their backpacks, 
but need to ensure that they are completely silent during 
class to avoid confiscation.

For iPhone users, the Do Not Disturb feature does not 
mean that you’ll miss truly urgent calls, though: if the same 
number calls you within 3 minutes of a blocked call, it is 
passed on through; that bypass can be disabled, too. You 
can also allow numbers in your Favorites list in the Phone 
and Contacts apps to make noise or vibration, even when 
all others are suppressed.

Further, the Phone app offers more options related to the 
calls that you don’t answer even when you’re willing to be 
disturbed. You can respond to an unanswered call immedi-
ately with a text message, including some preset ones  
(including custom presets: “I thought I told you never to call 
me while I’m being John Malkovich!”), or set a reminder 
for returning the call. And that reminder can include a 
geofence, so you’ll be alerted when you leave a meeting 
room or building.

Passbook — The new Passbook app aims to bring order  
to your collection of virtual movie ticket purchases, boarding 
passes, loyalty cards, and more – at least those that include 
2D barcodes that you need to present to scan for admission 
or purchase. Passbook can present and keep track of such 
items by both time and location, showing you, for example, 
your boarding pass information on the iPhone lock screen 
when you arrive at the airport. You can expect a number 

of vendors to turn up in Passbook as time goes on, as it 
requires some sort of integration, almost like a mini-app or 
widget.

Passbook could be a signal that Apple intends to incorporate 
near-field communications (NFC), a wireless technology 
for exchanging information at extremely short distances, 
such as by waving a device near or tapping a device on 
some kind of reader. Android added support for NFC in 
previous releases, and some Android phones include NFC 
hardware. However, without the commitment and integra-
tion of major retailers and other companies, like airlines, 
NFC won’t take off. Passbook could be both an indication 
of what’s to come and a precursor of announcements from 
Apple partners.

Enhanced Sharing — Those who can’t resist sharing 
every facet of their lives will appreciate the integration of 
Facebook into iOS for posting pictures and updates from 
within various apps, just like Twitter. This would seem to 
be the death knell for Ping, Apple’s music-oriented social 
networking service that never really got off the ground –  
a statement Tim Cook more or less agreed with in an  
interview at a recent tech conference.

More interesting is the new Shared Photo Streams feature. 
You can pick photos you’d like to share, and choose friends 
with whom you want to share. After that, your friends will 
receive push notifications about the shared photos, and the 
photos will appear in an album in the Photos app and on 
Macs in iPhoto and Aperture.

It will also finally become possible to attach photos and 
videos directly to messages from within the Mail app, 
rather than forcing users to initiate the process from the 
Photos app.

For those who like to share in real time, FaceTime gains the 
capability to work over cellular data connections as well as 
Wi-Fi. About time.

Safari Improvements — Safari in iOS receives a few 
interesting improvements, including iCloud Tabs, which 
enables you to view tabs open in other copies of Safari on 
your other iCloud-connected devices. Safari’s Reading List 
will be usable offline, which makes it significantly more 
useful for anyone who commutes on the subway or who 
wants to catch up with stored articles on an airplane.

When viewing Web sites in landscape orientation, you’ll be 
able to show them full-screen, without the device’s usual 
status bar at the top. And for sites that have their own iOS 
app, Safari can automatically pop up a banner informing 
visitors of a developer’s app, and a single tap will take 
them to the App Store to download it. If the user already 
has the app, tapping will switch to it, in exactly the same 
state as the Web site was.

Guided Access and Accessibility — With the new 
Guided Access feature, touch input to an app can be limited 
to only certain areas of the screen, and the new Single App 
mode disables the Home button, forcing the user of the 

http://www.apple.com/ios/ios6/#phone
http://www.apple.com/ios/ios6/#passbook
http://www.apple.com/ios/ios6/#facebook
http://www.apple.com/ios/ios6/#photostreams
http://www.apple.com/ios/ios6/#safari
http://www.apple.com/ios/ios6/#accessibility
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device to remain in a single app. For teachers using iPads 
in the classroom, we predict that these features will be 
popular for keeping students on task. For example, stu-
dents using a Multi-Touch textbook authored in iBooks 
Author could be restricted to just the iBooks app. And, 
with Guided Access, students could be blocked from 
tapping the Library button in iBooks in order to switch out 
to the iBookstore or any other titles available in the iBooks 
library.

Other accessibility related changes include VoiceOver 
support added to the Maps app, and a “Made for iPhone” 
program for creating and marketing iPhone-compatible 
hearing aids.

Lost and Found — A new Lost mode added to Find My 
iPhone lets you send a message to your missing iPhone 
that lets whoever found the phone call you with a single 
tap. “If they’re nice,” said Apple’s Scott Forstall while 

demonstrating the feature. Currently, Find My iPhone lets 
you send messages, lock your device, or wipe it. The Lost 
mode tracks the phone (it sounds as if it enables Find My 
iPhone if it’s off, although that’s unclear), locks the phone 
with a new four-digit passcode, and provides a pop-up 
menu with a prominent green Call button that the phone’s 
current possessor can tap to reach you.

Find My Friends will also add notifications based on 
location, with Apple providing the excellent example that a 
parent could be alerted when a kid leaves school or arrives 
home.

That’s It… For Now — That’s our brief rundown on the 
most touted of the 200 new features that iOS 6 will deliver 
when it is released in a few short months. Given that de-
velopers at WWDC received a beta of iOS 6, however, we 
suspect more details about it will emerge in the days and 
weeks to come.

A highly technical friend recently posted to a private 
mailing list of Mac and iOS programmers with an 

odd-sounding problem: after he updated his iPad 2 to iOS 
5.1, he lost about a quarter-inch of the screen on the top 
and bottom of his iPad. Everyone was stumped by his de-
scription of the problem, and it wasn’t until later, when he 
was messing around with the iPad in person with another 
friend, that they hit on the solution.

For unknown reasons, iOS on my friend’s iPad had decided 
to enable its Zoom feature. Hidden deep within iOS’s 
accessibility settings, Zoom enables people with low vision 
to magnify the entire visible screen, in essence turning the 
iPad’s physical display into a window on a much larger 
virtual display. The confusing bit for my friend is that he 
didn’t turn Zoom on intentionally, and he is neither the 
sort to do such things unintentionally, nor to share his iPad 
with someone else who might have. From what I can tell 
from reading a variety of Apple Support Communities 
discussions, it’s not entirely uncommon for Zoom to be 
toggled without the user’s knowledge, either by another 
user or by iOS gremlins.

Regardless of how or why Zoom can be enabled  
inadvertently, if you’re experiencing this problem, here’s 
how to solve it. Go to Settings > General > Accessibility 
> Zoom, and turn Zoom off. If, on the other hand, you’re 
thinking, “Hey, it might be nice to be able to zoom the 
screen on occasion,” you can turn Zoom on, and remember 
that the magic incantation to invoke it is a double-tap with 
three fingers. Those three fingers remain important, since 
double-tapping again returns you to the default magnification 

by Adam C. Engst  

Beware Accidental Zooming
in iOS (and OS X)

level. And, if you want to change the magnification level, 
double-tap with three fingers and then drag up (to make 
objects on screen larger) or down (to make them smaller).

When I raised this article topic on our TidBITS staff call, 
“Take Control of Using Lion” author Matt Neuburg 
immediately chimed in to say that he had heard numerous 
reports over the years of people running into roughly the 
same problem in OS X. It’s easier to zoom the screen acci-
dentally in OS X, where holding down the Control key and 
swiping up with two fingers on a trackpad or rolling up on 
a scroll wheel or scroll ball will zoom in. Swiping or scrolling 
down with the Control key held down zooms back out.

http://www.takecontrolbooks.com/lion-using?pt=TB1126
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The problem is that if you zoom only a tiny bit, the main 
evidence can be slightly fuzzy text and graphics, since 
everything is being scaled just a little, along with an oc-
casional slight movement of the entire screen because the 
zoomed image follows the position of the mouse pointer. 
(Users who have experienced this accidental zooming often 
describe feeling slightly nauseated by their screens.) This 
setting is off by default in OS X 10.7 Lion, but it was on by 
default in some earlier systems, so that users often stum-
bled on this feature by chance, without knowing what it 
was. On your machine, you may have turned it on, or you 
may have inherited an “on” setting from an earlier system.

In pre-Lion systems, this setting was available through 
the Mouse or Trackpad pane of System Preferences. In 
Lion, however, it can be harder to find, and the interface is 
somewhat deceptive. It appears, at first, that you control 
zooming in the Seeing view of the Universal Access pane 
of System Preferences. In reality, though, the overall Zoom 
setting can be set to off, but the trackpad/scroll wheel/
scroll ball approach still works if it’s enabled separately. 
(All that turning Zoom off really does is disable the 
Command-Option-plus/minus keyboard shortcuts for 
zooming to preset magnifications.)

The setting you want – “Use scroll wheel with modifier 
keys to zoom” – is in the dialog that appears when you 
click the Options button. (In Lion, you can also use “Zoom 
using scroll wheel while holding” in the Mouse preference 
pane; it applies universally, even though there’s no compa-
rable setting in the Trackpad preference pane.) Be careful  
in this dialog! It is very easy to change the modifier key 
setting accidentally when this dialog is open. I generally 
recommend leaving this feature turned on, though you 
might prefer to set the modifier-key trigger to something 
you’re less likely to use by mistake, such as Control-Option, 
or even Control-Shift-Option. It’s just too useful to be able 
to zoom in on something small on occasion.

For a full explanation of the many zoom options, see “Take 
Control of Using Lion,” where Matt has documented them 
exhaustively.

Take Control ebooks that expand on the Check out the 
topic in this article:

Take Control of Using Lion

With Matt Neuburg’s help, come up to speed on Lion’s 
key new features — Auto Save, Versions, Mission Control, 
Launchpad, gestures, full-screen mode, and more — and 
customize Lion to suit your needs. Whether you are excited 
about Lion’s new features or just want to get back to work, 
this ebook explains what you need to know.

http://www.takecontrolbooks.com/lion-using?pt=TB1126
http://www.takecontrolbooks.com/lion-using?pt=TB1126
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Over the last few months, I have had some issues with 
pictures I have taken. In both cases I needed a specialized 
program to fix my problem.

In the first case I wanted a short movie of a waterfall. Like 
many pictures, this was a once in lifetime not-to-be-repeated 
chance. We were at Aka Falls on the big island of Hawaii. I 
turned the camera for a portrait view and got a really good 
shot. 

June / July Software Review
by Tim Sullivan

However when I combined the movie with a lot a photographs 
in iMovie, the water flowed sideways, not down. Turning 
a photograph sideway — not problem. Turning a movie 
sideways — a bit of a problem.

I found TransformMovie by Limit Point Software.  
< http://www.limit-point.com/Utilities.html >It is a utility 
for rotating, filtering and sizing movies, or changing their 
duration (rate of play) in batch. Any movie supported by 
QuickTime can be transformed.

TransformMovie requires OS 10.4 or greater, runs on Intel 
and PPCl, and costs $9.99. 

It did the job easily and quickly.

More recently I accompanied my wife and one of her 
friends on a climb up the trail from Tumbling Run (about 4 
miles past Pine Grove Furnace Park.)

About 10 minutes up the trail we almost stepped on this 
critter. I was able to get this shot so my wife could have 
bragging rights for awhile.

http://www.limit-point.com/Utilities.html
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The problem occurred when we got to the top of the 
mountain. We were there for a memorial. Unfortunately I 
got the dreaded “MEMORY CARD FULL” message. Making 
an instant executive decision I erased the card. The rattler 
had to go to make room for more important pictures.

Later at home I wondered if it might be possible to 
resurrect the snake. I was able to find Disk Drill <http://
www.cleverfiles.com/> which requires OS 10.5 or later, 
runs on PPC or Intel. The cost is either free or $89 for the 
Pro Version. Besides recovering data the program can be 
used to protect data.

Again the program was easy to use and quick. It found all 
the deleted files that had not been written over. And right 
there at the end was the snake.

The catch with the free version is that the program will 
not restore the photographs nor will it move them off the 
memory card. It did allow me to see the photos with Quick 
Look at which time I cheated and grabbed the picture from 
the screen.

Apple Updates

MacBook Air (Mid 2012) Software Update 1.0 
Jun 13, 2012 - 1.06 GB
System Requirements

– OS 10.7.4 and build version 11E2520

This update is recommended for MacBook Air (mid 2012) 
models.

The update includes fixes that improve graphics stability, 
flash performance, and external display support.

Java for OS X Lion 2012-004 
Jun 12, 2012 - 64.07 MB
System Requirements

– OS X Lion 10.7 and later 

Java for OS X 2012-004 delivers improved security, reliability, 
and compatibility by updating Java SE 6 to 1.6.0_33.

This update configures the Java plug-in to deactivate when 
no applets are run for an extended period of time. If the 
prior update named “Java for OS X 2012-003” was not  
installed, this update will disable the Java web plug-in 
immediately. Java applets may be re-enabled by clicking 
the region labeled “Inactive plug-in” on a web page.

Java for OS X 10.6 Update 9 
Jun 12, 2012 - 76.34 MB
System Requirements

– Mac OS X 10.6.8

Java for OS X 10.6 Update 9 delivers improved security, 
reliability, and compatibility by updating Java SE 6 to 
1.6.0_33.

This update configures web browsers to not automatically 
run Java applets. Java applets may be re-enabled by clicking 
the region labeled “Inactive plug-in” on a web page. If no 
applets have been run for an extended period of time, the 
Java web plug-in will deactivate.

MacBook Pro (Retina) Trackpad Update 1.0 
Jun 12, 2012 - 1.26 MB
System Requirements

– MacBook Pro with Retina display notebooks

This update addresses an issue where the trackpad may 
not respond consistently to user input, and is recommended 
for all MacBook Pro with Retina display notebooks.

iMovie 9.0.6 
Jun 12, 2012 - 1.01 GB
System Requirements

– OS X version 10.7.4 or later

This update provides general stability and compatibility 
improvements, including:
•  Enhancements for the MacBook Pro with Retina display
•  Language support for Catalan, Croatian, Czech, 
Greek, Hungarian, Romanian, Slovak, Thai, Turkish and 
Ukrainian

MacBook Pro (Mid 2012) Software Update 1.0 
Jun 11, 2012 - 1.06 GB
System Requirements

– OS X Lion 10.7.3

This update is recommended for MacBook Pro (mid 2012) 
models.

The update includes fixes that improve graphics stability, 
external display support, and USB 3 device support.

Jun 11, 2012 - 11.09 MB
System Requirements

– OS X Lion 10.7.4 or later

This tool prepares libraries from iPhoto 5 or earlier so they 
can be upgraded with the current version of iPhoto.

AirPort Utility 6.1 for Mac 
Jun 11, 2012 - 21.59 MB
System Requirements

– Mac OS Lion 10.7.3 or later 

AirPort Utility 6.1 allows you to configure and manage the 
new AirPort Express with simultaneous dual band 802.11n. 
It also allows you to configure the base stations for IPv6 
and includes additional bug fixes.

AirPort Utility 5.6.1 for Mac 
Jun 11, 2012 - 10.15 MB
System Requirements

– OS X 10.5.7 to 10.6.8

iPhoto Library Upgrader 1.0 

http://www.cleverfiles.com/
http://www.cleverfiles.com/
http://support.apple.com/kb/DL1551
http://support.apple.com/kb/DL1515
http://support.apple.com/kb/DL1550
http://support.apple.com/kb/DL1543
http://support.apple.com/kb/DL1541
http://support.apple.com/kb/DL1542
http://support.apple.com/kb/DL1523
http://support.apple.com/kb/DL1537
http://support.apple.com/kb/DL1536
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AirPort Utility 5.6.1 allows you to configure and manage 
the new AirPort Express with simultaneous dual band 
802.11n. 

iTunes 10.6.3 
Jun 11, 2012 - 170.27 MB (OS X) 73.67 MB
System Requirements

– OS X 10.5.8 or later
– Safari 4.0.3 or later

iTunes 10.6.3 includes support for OS X Mountain Lion and 
addresses a number of important issues:
•  Addresses a problem where iTunes may become 
unresponsive when syncing an iPad (1st generation) that 
contains an iBooks textbook
•  Fixes a problem where photos synced to a device may 
appear in an unexpected order
•  Resolves an issue where iTunes may unexpectedly delete 
playlists created on a device
•  Fixes issues where iTunes may unexpectedly delete apps 
on a device
•  Improves overall performance and fixes a number of  
important issues.

iPhoto 9.3 
Jun 11, 2012 - 599.65 MB
System Requirements

– OS X Lion 10.7.4 or later

What’s New in Version 9.3
•  iPhoto can now open libraries from Aperture 3.3 or later
•   AVCHD video is now supported
•  The Description field now automatically expands as 
needed when entering text
•  You can now flag a photo in Magnify (1-up) view by 
clicking a Flag icon displayed in the upper left corner of 
the photo
•  Keywords and titles are now preserved when exporting 
files with embedded GPS location data
•   A new Export option allows you to automatically 
organize exported photos into subfolders by event 

The update is recommended for all users of iPhoto ‘11.

Aperture 3.3 
Jun 11, 2012 - 528.37 MB
System Requirements

– OS X Lion 10.7.4 or later

What’s New in Aperture 3.3
• New unified photo library for both iPhoto (v 9.3 or later) 
and Aperture; no import/export required; Faces, Places, 
slideshows, albums and web sharing work across both 
applications
• Support for AVCHD video has been added
• Aperture now lets you use camera-generated previews 
for faster browsing of RAW files immediately after import
• Highlights & Shadows tool has been updated to deliver 
higher-quality results and work with extended range data
• A new Auto Enhance button has been added to the  
Adjustments panel

• White Balance tool now includes Skin Tone and Natural 
Gray modes to simplify color balance
• Auto button has been added to the White Balance tool for 
one-click color balancing
• Set Desktop command has been added to Share menu so 
you can set a desktop background from within Aperture
• A new Manual option allows you to drag and drop 
projects to customize sort order in the Projects view
• New preference allows you to set the background 
brightness of the full screen browser
• Facebook, Flickr, and MobileMe albums are now  
displayed as thumbnails in the main window when accounts 
are selected in the source list
• Minor terminology changes, including “Original” instead 
of “Master” and “Info” instead of “Metadata”
• Source list includes a new “Recent” section, showing Last 
Import and recently-viewed projects
• Raw Fine Tuning is no longer displayed in the Adjustments 
panel by default
• Faces can now be named by dragging them from the 
Unnamed Faces browser to existing snapshots on the 
corkboard
• The Faces corkboard now includes a menu that allows 
you to set the order of face snapshots
• Newly designed monochrome source list and toolbar 
icons
• Addresses numerous issues related to overall performance 
and stability

The update is recommended for all users of Aperture 3.

Motion 5 Content v.1.1 
Jun 11, 2012 - 1.05 GB
System Requirements
– OS X 10.6.8 or OS X Lion 10.7.4 or later

This update includes the following Motion 5 content 
enhanced for the Macbook Pro with Retina display:
•  Motion Templates: A variety of professionally-designed, 
customizable templates.
•  Motion Library Content: Animated vector graphics, 
backgrounds, template media, sample Motion projects, and 
royalty-free still images.

This update is recommended for all users of Motion 5.

– OS X 10.6.8
– OS X Lion 10.7.3 or later

What’s New in Aperture 3.2.4
•  Improves stability on OS X Snow Leopard.
•  Addresses an issue that could prevent the Viewer from 
updating correctly after editing a photo using an external 
editor.
Included in Aperture 3.2
• Addresses compatibility with iCloud and iOS 5

Aperture 3.2.4  
May 24, 2012 - 635.54 MB
System Requirements

http://support.apple.com/kb/DL1426
http://support.apple.com/kb/DL1545
http://support.apple.com/kb/DL1540
http://support.apple.com/kb/DL1549
http://support.apple.com/kb/DL1538
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• Resolves an issue that could cause the “Loading”  
indicator to reappear in the Viewer when cropping a photo
• Aperture now automatically relaunches into Full Screen 
mode if the application was in Full Screen mode when last 
quit
• Pinch-to-zoom gesture now automatically activates 
Zoom mode in the Viewer
• Left and right swipe gestures can now be used to navigate 
between photos in the Viewer
• Microsoft Outlook can now be chosen in Preferences as 
the application used by Aperture for emailing photos
• Fixes a problem that could cause Aperture, running on 
OS X Lion, to quit unexpectedly when using brushes to  
apply adjustments
• Loupe now correctly displays magnification levels between 
50-100%
• Fixes an issue that could cause Aperture, running on OS 
X Lion, to display the incorrect color profile on externally 
edited images
• Import window now includes an option to delete photos 
from iPhone and iPad after they have been imported into 
Aperture
• The Lift & Stamp tool now displays the correct cursor 
icons when being used in Split View and Viewer only 
modes

The update is recommended for all users of Aperture 3.

Digital Camera RAW Compatibility Update 3.13 
May 22, 2012 - 8 MB
System Requirements

– OS X 10.6.8
– OS X Lion 10.7

This update adds RAW image compatibility for the  
following cameras to Aperture 3 and iPhoto ‘11:
•  Canon EOS-1D X
•  Nikon D800E
•  Nikon D3200
•  Olympus OM-D E-M5
•  Panasonic LUMIX DMC-GF5
•  Sony Alpha SLT-A57

Flashback Removal Security Update 
May 14, 2012 - 1.23MB
System Requirements

– OS X v10.5.8

This update removes the most common variants of the 
Flashback malware. If the Flashback malware is found, a 
dialog will notify you that malware was removed. In some 
cases, the update may need to restart your computer in 
order to completely remove the Flashback malware.

OS X Lion Update 10.7.4 (Client) 
May 9, 2012 - 692.68 MB
OS X Lion Update 10.7.4 (Client Combo) 
May 9, 2012 - 1.4 GB
System Requirements

– OS X Lion 10.7.3

The 10.7.4 update is recommended for all OS X Lion users 
and includes general operating system fixes that improve 
the stability, compatibility, and security of your Mac in-
cluding fixes that:
•  Resolve an issue where the “Reopen windows when  
logging back in” setting is always enabled
•  Improve compatibility with certain British third-party 
USB keyboards
•  Address an issue that may prevent files from being 
saved to a server
•  Improve the reliability of copying files to an SMB server

Safari 5.1.7 
May 9, 2012 - (44.98 MB OS X Lion) (47.72 MB Snow 
Leopard)
System Requirements

– OS X Lion 10.7.3 
– OS X Snow Leopard 10.6.8

Safari 5.1.7 contains improvements to performance, stability, 
compatibility, and security, including changes that:
•  Improve the browser’s responsiveness when the system 
is low on memory
•  Fix an issue that could prevent webpages from responding 
after using a pinch to zoom gesture
•  Fix an issue that could affect websites using forms to  
authenticate users
•  Disable versions of Adobe Flash Player that do not include 
the latest security updates and provide the option to get 
the current version from Adobe’s website.

Security Update 2012-002 (Snow Leopard) 
May 9, 2012 - 238.73 MB
System Requirements

– OS X 10.6.8

Security Update 2012-002 is recommended for all users and 
improves the security of OS X.

http://support.apple.com/kb/DL1535
http://support.apple.com/kb/DL1534
http://support.apple.com/kb/DL1525
http://support.apple.com/kb/DL1524
http://support.apple.com/kb/DL1531
http://support.apple.com/kb/DL1526
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by Christopher Breen

Mac 911
Locating and dispensing with old applications 

Reader Chas Hamilton has come down with a case of 
spring-cleaning fever. He writes: 

I was just looking at my Applications folder that contains hundreds 
of apps and realized that there are a lot of old things in there that 
I never used. I came up with the clever idea to sort my applica-
tions by the date they were last opened so that I could toss out 
old apps. (I figured that if I hadn’t touched something in the last 
two years I wasn’t likely to.) I’m running Snow Leopard and the 
problem is that when I open my Applications folder and choose 
View -> View Options, the option to view files by Last Opened is 
grayed out. Is there some way to make it active? 

You’re correct, Apple disabled that option in Snow Leopard. 
I’ve attempted to edit the com.apple.finder.plist file in 
order to make it active with no luck (though you can edit 
this file to enable other view options). But where there’s a 
will (or, at least, a Chris), there’s a way. 

Open the Applications folder and then press Command-F. 
In the resulting search window click on Applications at 
the top of the window so that you’re searching that fold-
er. Configure the pop-up menus at the top of the window 
to read Last Opened Date is Before X/X/2010 (a data 
approximately two years ago). Click the Plus button to 
create another condition. Configure this one to read Kind is 
Application. (You do this because your Applications folder 
may contain files that haven’t been opened in the last two 
years.) 

The list below should contain only those applications that 
you haven’t opened in the last two years. If you don’t see 
a Last Opened column in this window, press Command-J 
to bring up the view options window and enable the Last 
Opened option (which, in this case, does work). With this 
column visible you can then sort the list by date, making 
it easy to locate those applications that you really, really 
haven’t used lately. 

Naturally, before tossing out these less-favored applications 
you’ll want to examine them carefully so that you don’t 
discard something that you anticipate needing some day. 

Note that if you’re running Lion, this isn’t an issue as Date 
Last Opened is enabled in view options. 

Empty the #$&@! trash already! 

Reader Jim Young has a trash that’s starting to stink up the 
place. He writes: 

I found that I was running out of space on my hard drive so I 
located some large files and tossed them in the trash. But when I 

tried to empty the trash I received a warning indicating that the 
trash couldn’t be emptied because of a —8003 error. I really need 
to empty the trash but it won’t respond. What can I do? 

I wouldn’t bother trying to learn what that specific —8003 
error means. The Mac can throw up all kinds of error codes 
and very few of them make sense (or have much published 
about them). Instead, just assume something’s mucked up 
and go from there. 

We’ll start with general muckage. Launch Disk Utility (/
Applications/Utilities), select your startup drive in the left 
side of the window, click the First Aid tab, and click Verify 
Disk. Disk Utility will perform a check of your startup vol-
ume looking for any obvious errors. If it finds any errors, 
boot from another volume (in Lion this can be the Recov-
ery HD partition, in earlier versions of the Mac OS, boot 
from the latest OS X installer disc). Again, run Disk Utility 
from this new volume, select your regular startup volume, 
and click Repair Disk. 

With luck, everything will be repaired, you’ll return to 
your startup drive, and be able to empty the trash. Without 
that luck, you may have to turn to a sterner utility such as 
Alsoft’s $100 Disk Warrior. 

You say that Disk Utility found no problems yet you still 
can’t empty the trash. If you like pushing buttons, return 
to Disk Utility, select your startup volume, choose First 
Aid, and click the Repair Permissions button. Any luck? I 
thought not. 

If you’re at the end of your rope in a “For cryin’ out loud, 
Chris, just tell me how to empty the dratted trash already 
because I’m pretty sure this is a case of a corrupt file” kind 
of way, okay, here’s the answer. Download a utility that 
ignores OS X’s objections and takes out the trash like you 
asked it to. There are a variety of these tools – all of which 
plaster a nice GUI on Unix commands. The one I prefer 
is Titanium Software’s Onyx. It’s free and it works. What 
more could you ask for? 

Launch Onyx and allow it to run a couple of tests on your 
drive. Once those tests come up negative select the Utilities 
tab, click the Trash tab in the window, and make sure that 
the Delete option is selected. Click on Execute and Onyx 
should go where the Mac OS refused to and empty the 
trash. 

Just to be sure that the problem’s root isn’t deeper down 
in the system, quit Onyx, toss a file you don’t need in the 
trash, and empty the trash. If it flushes as expected you 
should be good to go. 



June / July 2012   Page 14

�

Remotely transfer iPhoto images to iPhone 

Reader Robert Zavod would like greater access to his photos from 
his iPhone. He writes: 

When using my iPhone on the road, I’d like to access my iMac 
and its iPhoto library and move some of the images in that library 
to my iPhone. Is there a way to do that? 

Yes. There are a couple of ways to approach this. The first 
is the dead-simple way (recently suggested to me by reader 
@snaab via Twitter) and the second is my original method, 
which can be more broadly helpful for communicating 
remotely with your Mac but is more complicated. We’ll 
start with the simple solution. 

On your iPhone download a copy of Tunaverse Media’s 
free Blinq Photo app. On your Mac, travel to Tunaverse’s 
website and grab an equally-free copy of Blinq for Mac. 
Fire up the Mac client and create an account (this requires 
that you create a username and password and enter an 
e-mail address). Once your account has been created you’ll 
be asked whether you’d like Blinq to use your iPhoto or 
Aperture library. Choose iPhoto. 

Now shift over to your iPhone, launch the Blinq app, and 
log in with the account you just created. In a short while, 
your Mac will appear as one of Blinq’s photo sources. Tap 
on the computer icon to view your iPhoto albums. Tap an 
album or event, select an image, and from the Action menu 
at the bottom-right of the screen choose Save to Photos 
App. The image is then copied from your iPhoto library to 
your iPhone. Regrettably you can choose to copy only one 
image at a time. 

Now for the more complicated way. 

That more complicated way is a two-step conundrum. The 
first is that you must find a way to access your iMac. The 
second is moving the images you want to your iPhone. 
We’ll take them in order. 

Although it really should go without saying, for this to 
work your iMac must be running. Also, you must have an 
iCloud account and the latest version of iPhoto. You 
additionally must select iCloud in Settings on your iPhone 
and enable Photo Stream. 

Now that we have that straightened out, you’ll next need 
an iOS app that allows you to connect to and control your 
Mac remotely. There are a variety of these app. I’ve used 
Edovia’s $20 Screens VNC, the $20 iTeleport for iPad, and 
the $3 Splashtop Remote Desktop for iPad and each can do 
the job, both on the same local network as your computer 
and from across the Internet. 

What these apps do is show you your iMac’s screen on 
your iOS device. Using one gesture or another, you then 
navigate that screen just as you would if you were sitting 
in front of the computer. 

Now that you can do that, remotely launch your copy of 
iPhoto on your iMac. Navigate to the images that you’d 
like to eventually see on your iPhone and select them. 
Move to the Share menu and choose Photo Stream. The 
images you selected will be uploaded to iCloud’s Photo 
Stream. 

All you have to do now is wait for iCloud to work its 
magic. Eventually the images you selected in iPhoto will 
appear in the Photos app on your iOS device within its 
Photo Stream album. 

[Macworld Senior Editor Christopher Breen is the author of  
“Secrets of the iPod and iTunes (6th edition),” and “The iPod 
and iTunes Pocket Guide (4th edition)” both from Peachpit Press 

and 

“OS X 10.5 Leopard Essential Training (video)” from lynda.com 
Find Chris’ books at www.amazon.com and www.peachpit.com. 
Get special user group pricing on Macworld Magazine! Subscribe 
today at http:// www.macworld.com/useroffer 
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